Outlook 2007 

User Guide

[image: image1.jpg]



December 2010
Table of Contents

Title









Page

General

	Login 
	3

	Web Access
	3

	Organizing Mail
	3

	Setup Tool Bars
	4

	Reader Pane
	7

	Folders
	7


Mail

	Create & Send Mail
	9

	Delete Mail
	10

	Recall Message
	11

	Create Mail Distribution List
	12

	Set Mail List Default
	14

	Create a Contact
	15

	Delete a Contact
	17

	Create Stationary
	18

	Create Rules
	19

	Create a Signature
	23

	Template (Stationary)
	24

	Retrieve a Template
	25

	Edit a Template
	26


Calendar

	Work Schedule
	27

	Time Zone
	28

	Free/busy
	30

	Add Holidays
	31

	Adjust Calendar Time Scale
	32

	Create Appointments
	32

	Delete Appointments
	33

	Create Meetings
	34

	Delete Meetings 
	37

	Setup Out of Office
	39

	Print Calendars
	41

	Print Shared Calendars
	46

	Schedule a Room
	47

	Add Color to Calendar
	50


Task

	Create a Task
	51

	Assign a Task
	53

	Update a Task
	54

	Close a Task
	55


Login
Web Access to Email

Open browser and enter https://mail.nebraska.gov
Enter LAN user id and password. Press enter key or click on Log On button
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Organizing Mail

Use the mail organizing feature to setup the mail box using folders, color and views 
Click on Tools and Organize. 
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The “Using Folders” tab is used to move mail to specific folders or to create new folders. Use the Rules and Alerts feature to automate the routing of messages to folders. 
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The “Using Colors” tab is used to color code messages for easier identification as to who it’s from or sent to. Use the down arrow in the first text box to set from or sent to status. In the middle text box enter the name of the sender/recipient. Use the down arrow of the third text box to locate and select the desired color. Click the “Apply Color” button to activate the set up.  
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To single out messages sent only to you, click on the “Turn Off” button to display the color menu. Use the down arrow to find and select the desired color. 
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Use the “Using View” tab to setup how mail view is displayed. There are eight views to select from. Use the arrows to scroll and select desired view. 
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Close the Organizing function by clicking on the X in the upper right hand corner of the screen. 
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Setup Tool Bars

In Outlook the look of the standard and advance toolbars differs for each function. Users can customize the tool bars to meet their needs. In the Mail function there are separate tool bars for the mail function and the new mail view. 
Mail View

On the menu bar find and click on View and toolbars. To get the best assortment of options users should select both the Standard and Advanced settings. 
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Row two of the menu bar is the standard toolbar, row three is the advanced tool bar. 
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To further personalize the options available click on Customize. This function is used to select toolbars, commands and options. 
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Click the “Commands” tab to add buttons to the menu bar. Left click and drag the button to the tool bar and release.   
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The “Toolbars” tab is another location to setup the overall view of the menu bar. 
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The “Options” tab is used to establish settings for how menus, toolbars and icons are displayed.  
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Reader Pane

To set the Reader Pane setting click on View on the menu bar then Reader Pane. There are three options, Right, Bottom or Off. Click on the desired option. 
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Use the reading pane [image: image22.png]


 button to turn the reader pane on or off. 

Folders

Outlook comes with pre-established folders. The folders can be displayed or not displayed. Use the All Mail Items down arrow to change the display view. Mail items are moved to the folders by clicking on them and dragging them to the folder.

There are two other options to move items to folders, click on move to folder button [image: image23.png]


 or click on [image: image24.png]


 to setup rules to automatically move items to designated folders. 

[image: image25.png]MailFolders 2
At waittems .

5 & isitbox - Davidson-wr
&) Deleted Items (2]
() Drafts 11]
@ E Inbox
Junk E-mail [40]
(3 outoor
Rss Feeas
Senttems
05 Searcn Folders




New Folder

To create a new folder click on the new folder button [image: image26.png]


.
Enter the name of the folder. 
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Use the down arrow of the Folder Contains box to identify what the folder will contain.
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Click on the icon for the location for the folder. Click OK.
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The folder is displayed in the folders navigation pane in alphabetical order. 
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Create & Send Mail

To create a new message click on the New button [image: image31.png]


. 
Click on the To button to access mail lists or enter the name of the individual on the To line. CC and Bcc can be completed on the same view as the To when using mail lists. 
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The mail lists can also be accessed by clicking on the Address Book button on the menu ribbon. 
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Enter the subject title. 
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In the body of the New Message view create the note. Use the spell check button to ensure correct spelling of all words. 
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To attach documents to the message click on the Insert Tab to activate options. If attaching a file click on the “Attach File” (Paper Clip) button. To attach an item attached to another email message click on “Attach Item” button. 
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Click on [image: image37.png]


 to mail the message. 

There are a variety of tools available on the Message, Insert, Options and Format Text tabs. Try them out, experiment. 
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Delete Mail

There are number of ways to delete mail. 
1. With the email message open click on the delete button  [image: image39.png]


. 
2. Click on the Microsoft icon [image: image40.png]


 and delete. 
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3. With the selected email closed click on the delete button [image: image42.png]


 or use the Edit and delete option. 
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Deleted items are moved to the Delete folder. 

Recall Message

1. Open message to be recalled. 

2. Click on “Other Actions” 
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3. Locate and click on “Recall This Message”
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4. The text box below is displayed, check appropriate response and click OK. 
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In this example a notification of success was requested. 
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5. Close the message. 
Create Mail List

In the Contacts view click on Actions and “New Distribution List” or on the Distribution List [image: image48.png]


 button.
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Enter the name of the list in the “Name” text box. 
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To create the distribution list click on “Select Members” button on the ribbon. 
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Use the Address Book menu to select the mail list. In the Search box enter the name/s to locate the individual’s address. Click on the “Members” button to add the name to the new list. Repeat as needed. Click OK when all members have been selected. 
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The new distribution list is displayed. 
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If individuals who are not on the State address lists need to be added to the new distribution list click on the “Add New” button.
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Enter the person’s name and email address. The check box is available to create a contacts entry for the individual’s information in the contacts view. Click OK. 
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Click the “Save & Close” [image: image56.png]


 button. 

Edit List

Once a distribution list is created it can be edited using the “Select Members”, “Add New”, and “Remove” buttons on the ribbon. Always save after making changes. 

To delete the entire list open it and click the Delete button on the ribbon. 
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Set Mail List Default

To set the mail list default click on Tools then Address Book. 
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Click on Tools then Options. 
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Use the down arrow to scroll through mail list choices. Click on desired mail list. Click OK. 
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Create a Contact
The Outlook contacts feature is used to identify and capture contact information on those individuals we interact with on a regular basis or for those we need to locate contact information on quickly.  The focus in this section is on the creation of the contact information for an individual.
Click on the “Contacts” button on the menu to display the contact feature. 
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Contacts can be displayed in a number of formats. In the “Current View” click on each option and determine for yourself which format best fits your needs. 
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Click on the “New” button on the menu. 
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In the first section enter the person’s name, company name and job title. Identify how the record is to be filed as, click on the down arrow to view options. 
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In the internet section either use the E-mail directory to locate the desired email or type in the email address.  Enter the Web and IM address if the contact has one and you want to use them. 
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In the phone number section enter the business number, home number if known and appropriate, business fax number and mobile phone number. In the address section enter the physical address of the contact. Click on the “This is the mailing address” check box to indentify the mailing address.  
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The notes section of the form can be used to document or store information. The Contact, Insert and Format Text ribbon functionality are available for use within the Notes section. 
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Click on the “Save & Close” button to save the contact information and to close the application. 
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Delete a Contact 

Select and open the contact. Click on “Delete”.  The contact is deleted. 
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Create Stationary

To select a stationary format click on Tools [image: image71.png]


 and then [image: image72.png]Options.




. 

Click on the Mail Format [image: image73.png]Mail Format



tab. 
To select a background click Stationery Picker. 
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 tab click on the “Theme” button. 
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Use the down arrow to view choices. Click on format desired. 
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Click OK. 

Click on the Fonts button to view font options. 
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There are a number of font options available see text box below to establish font rules. Click OK. 
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Create Rules

Outlook provides a wizard type process which walks the user through the process to create rules for mail. There are numerous rule creation possibilities it is beyond the scope of this guide to cover all of them. One example is provided to illustrate the over all generic rule creation process. 
Click on “Tools” then “Rules and Alerts”. 
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Click on the “New Rule” button on the E-mail Rules tab. 
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Step 1 offers a variety options including templates to begin building the rule. Select an option and move to step 2. 
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In this step 2 example a template was selected. Click on “people or distribution list”.  
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Use the Address Book to locate and select the contact information for the person or distribution list. 
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Click [image: image85.png]OK.




Click on “specified”. 
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Locate, highlight the desired folder and click OK. 
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The next screen is an opportunity to select conditions for the rule. Select by clicking on the check box. 
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Click  [image: image89.png]Mext >




The next box asks how the message is to be handled. Click on the check box for the desired action. 
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Are there exceptions to the rule? Use options to set exceptions. If are not exceptions click Next. 
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The rule setup is complete. Check the descriptions for step 1-3 to verify they are correct. 
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If the rule looks OK click [image: image97.png]



The new rule is displayed in the rule menu. 
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Click [image: image99.png]OK.



 

Create a Signature

To create a signature click on Tools [image: image100.png]


 and then [image: image101.png]Options.




. 

Click on the Mail Format [image: image102.png]Mail Format



tab. 
Click on the “Signatures” button. 
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Click on the “New” button. 
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Enter the name for the new signature and click OK. 
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Use the “Edit signature” bar tools to select the style, font, color and alignment of the signature. Enter the signature information. Click “Save”. 
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Click the [image: image107.png]


 button on this screen and the next screen. 
Create a Template 
To create a new template click on the [image: image108.png]


 mail button. 

If the form is normally sent to the same people set up the To and Cc boxes. 
On the Subject line enter the name of the form.

In the body of the note create the document / form. Forms created in Word or Excel can be pasted into the body.   
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Once the form is created click on the Microsoft icon [image: image110.png]


 in the upper left corner of the note. 

Click on [image: image111.png]


 
Use the “Save as type” down arrow to find and select “Outlook Template”
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Click [image: image113.png]



The form can either be sent or closed. 

Retrieve a Template

To retrieve the template for use click on Tools, Forms and Choose Form
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Use the Choose Form down arrow to locate and select “User Templates in File System”
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Locate and select the desired form. 
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Click [image: image118.png]



Modify the form as needed and send. 

Edit Templates
Retrieve and make changes to the template. Click on [image: image119.png]


 icon. Click on Save As.
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Click on the down arrow for Save as type. Locate and select Outlook Template (*oft).
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A prompt asking if OK to replace existing template. Click Yes. 
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Send or close the template. If you select close you are prompted to save changes, click Yes.  
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Work Schedule

The user has the option to setup their work schedule. The work schedule does not display availability on the user’s calendar. 
Click on Tools then Options. 
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On the Preferences tab click on Calendar Options. 
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To establish work schedule click on the boxes of the days normally worked. Identify the first day of the work week and first week of the year. Enter the normal start and end time for work schedule. Click OK. 

[image: image126.png]Calendar work week-
| s Osat

First day of week: |Sunday | starttime: 630 am v
Fist weskof year: [StartsonJan1 v | Endtine:  [3:00PM v





Calendar Options

Calendar options is used to allow attendees to counter propose meeting times and to set a default response when you propose a new meeting time (tentative, decline or accept). 
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To set or change the background colors for the calendar click on the down arrow of the background color box. Check the “Use selected color on all calendars” box if the color is desired on all calendars. 
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Time Zone

To set or change the time zone click on the [image: image129.png]


 button in the Calendar Options view. 

In the Label text box enter a name for the time zone. This is an optional step. 
Use the down arrow on the Time Zone text box to locate and select the desired time zone. 
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If a second time zone is desired click on the box for “Show an additional time zone” Enter a name in the Label text box. This is an optional step. Use the Time Zone down arrow to locate and select the desired time zone. 
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Click on “Swap Time Zones” button to switch between the two time zones selected. 
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Click OK.
Free/Busy

Under the Advance Options the Free/Busy feature is used to setup the number of months out that the free / busy times on the calendar are displayed. This feature is also used to set the frequency of calendar updates. Click on the Free/Busy button.
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Select the permission level. The OCIO standard is Reviewer with Full Details.
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Click [image: image135.png]



To change the Outlook calendar settings to let others view your free/busy time more than 2 months out, go to the Tools dropdown menu and select Options.
Under the Preferences Tab, select Calendar Options.
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Click  [image: image137.png]Free/Busy Options.



 button
Click “Other Free/Busy” 
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Change the number of months of Calendar free/busy information on the server to 12 months (or to what’s deemed appropriate).
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Click [image: image140.png]



Add Holidays

In the Calendar Options view click on [image: image141.png]‘Add Holidays,




Use the Up and Down arrows to locate and select the desired national holidays. Click OK. 
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Adjust Calendar Time Scale

In the Calendar view click on View and Current View. 
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Click on [image: image144.png]Customize Current View.




Click [image: image145.png]Other Settings.



 button
Use the Time Scale down arrow to locate and select the desired time scale. 
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Click [image: image147.png]



Create Appointments 
In the Calendar view click on the [image: image148.png]


 button. The tool bar can be setup so appointments can be initiated in the Mail view too. 
In the subject text box enter the title for the appointment. Enter the location of the appointment in the Location text box.
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Use the drop down menus to set the start / end dates and times.  Use the “All day event” check box if appropriate.
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Use the “Show As” feature to identify how the appointment is to be displayed on the calendar. Use the “Reminder” feature to set an automatic reminder if desired. If the appointment is a recurring one use the “Recurrence” feature to setup the appointment schedule. 
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The body of the screen is used to add notes. 
Click the [image: image152.png]Savea
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 button. 

Delete Appointments

In the calendar view locate and double click on the appointment to be deleted.  
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Click on Delete on the Appointment Ribbon. 
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The appointment is removed from the calendar. 

Deleting Recurring Meetings

For recurring meetings double click on the appointment to be deleted. 
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The box below is displayed. The options are to work with the date selected or the whole series of dates. Click on the radio button before the desired option and then click OK. 
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The appointment document is opened. Click on the  [image: image157.png]X pelete



 button found on the Recurring Appointment tab of the ribbon.  

The box below is displayed and asks for confirmation that it’s OK to delete the appointment option selected.  Click OK. 
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The appointment or the series of appointments are removed from the calendar. 

Create Meetings

The difference between an appointment and a meeting is that others are invited to attend a meeting. Click on the Meeting Request button [image: image159.png]


 on the menu bar. 
In the To box identify the meeting participants. Use the mail lists to select participants, conference room and equipment resources. Fill in the subject and meeting location boxes. 
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Use the down arrows on the Start and End time boxes to select date and time for the meeting. If the meeting is an all day event check the “All day event” box. 
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Use the “Show As” function to identify how the meeting is to be displayed on the calendar. Use the “Reminder” function to set an automatic reminder if desired. If the meeting is a recurring one use the “Recurrence” function to setup the meeting schedule. 
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To check the availability of the participants and room click on the [image: image163.png]Scheduling
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 button on the ribbon.  

The calendars for the meeting attendees, rooms and equipment are displayed. 
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Outlook offers alternative meeting times in the lower right hand corner of the screen. 
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To add participants click on the “Add Attendees” button. The mail distribution lists are displayed. Select additional attendees from lists. The “Options” button is used to identify how the scheduling calendar view is displayed. The “Add Rooms” button is used to display and schedule conference rooms.  
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Use the text box to provide descriptive information on the meeting. Use the 

Spell Check feature to check spelling of the meeting notice information. 

To attach documents click on Insert tab to activate it. 
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Click on the “Attach File” function. Locate and select file. 
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Click on the [image: image169.png]


 button to distribute the meeting notice. 
Delete Meetings

In the calendar view locate and double click on the meeting to be deleted.  
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On the Meeting Ribbon click on “Cancel Meeting”
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Click the “Send Cancellation” button. The cancellation notification is sent to everyone on the distribution list. 
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The meeting is removed from the calendar. 

Delete a Recurring Meeting

In the calendar view locate and double click on the meeting to be deleted.  
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The box below is displayed. The options are to open just this occurrence or the whole series of dates. Click on the radio button of the desired option and then click OK. 
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The meeting document is opened. Click “Cancel Meeting” on the Recurring Meeting tab of the ribbon.
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Click the “Send Cancellation” button. The cancellation notification is sent to everyone on the distribution list. 
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When cancelling a meeting that’s part of a series Outlook asks for verification. Select options and click OK.  
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The meeting is removed from the calendar. 
Setup Out of Office
In the Mail View, click on Tools then on “Out of Office Assistant.” 
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To send out of office replies click the radio button titled “Send Out of Office Auto-Replies”. 
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Click on the box “Only send during this time range.” Use the down arrows to set the start and end dates and times. 
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Click on the “Inside My Organization” tab. In the text box enter the auto-reply message to be sent to the senders within the organization.  
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Click on the “Outside My Organization” tab. Click on the “Auto-reply to people outside my organization” box to activate the text box. Use the radio buttons to set the parameters for the auto-reply message (contacts only or anyone outside). 
Enter the message in the text box. 
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If special handling of incoming mail is not needed click OK to save settings.  
In those situations where incoming mail needs to be routed to others or to specific locations such as an inbox or folder rules are required. Click the [image: image183.png]


 button. 

Click on “Add Rule” button.
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Rules are built around who the mail is from, who it is sent to, the subject or message. Multiple names can be selected for both the From and Sent To categories. 

Identify the sender/s. 
Click the From Button to identify senders, use mail lists.

Click the Sent To Button to identify recipients, use mail lists. 
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Rule options include creating an Action (text / sound alert), Move or Copy to mail box or public folder, forward to another person/address and reply with template. 
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Remember to reset Out of Office to in upon return to work. 

Print Calendar
Access the calendar function by clicking on the Calendar button [image: image187.png]


.

From the menu select the desired view (Day, Week or Month)
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On the menu bar click on File and then Print.
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Check the printer box to ensure the correct printer is selected. 
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If more than one calendar is displayed on the calendar view use the down arrow on the “Print this calendar” box to find and select the desired calendar. Only one calendar can be printed at a time. 
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In the “Print style” box locate and select the calendar style desired. Five styles are available (Daily, weekly, monthly, tri-folded and calendar detail). 
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Verify in the “Print Range” box that the date ranges are correct. Click Ok to print the calendar.  
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Printing Shared Calendars

Access the calendar function by clicking on the Calendar button [image: image195.png]


.

From the menu select the desired view (Day, Week or Month)
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If the other person’s calendar is not already selected click on “Open a Shared Calendar”
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Type in the person’s name and click OK. 
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If more than one name is displayed select the correct name and click OK.
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The person’s name is displayed in the navigation panel to the left and their calendar is displayed to the right of the requesters. 
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On the menu bar click on File and then Print.
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Check the printer box to ensure the correct printer is selected. 
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If more than one calendar is displayed on the calendar view use the down arrow on the “Print this calendar” box to find and select the desired calendar. Only one calendar can be printed at a time. 
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In the “Print style” box locate and select the calendar style desired. Five styles are available (Daily, weekly, monthly, tri-folded and calendar detail). 
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Verify in the “Print Range” box that the date ranges are correct. Click Ok to print the calendar.  
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Share Calendar with Others

To share your calendar with another person click on “Share my Calendar” located on the navigation panel on the left side of the screen. 
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The share request text box is displayed. Use the To button to identify the person/s being invited to share your calendar. Use the check box labeled “Request to view recipient’s calendar” if you want access to view the recipient’s calendar. Use the body of the box to include a message. Click the Send button. 
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Outlook asks one last time if it’s OK to share before sending the email notification. Click Yes to continue process. 
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Outlook gives verification that the calendar is now being shared. Click OK. 
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The request message is sent to the recipient. They can now access the calendar and have the option of granting or denying the requester access to their calendar. 

Schedule a Room

Click on the Meeting Request [image: image211.png]


 button. 
Click on the To [image: image212.png]


 button. 

Use the Address Book down arrow to locate and click on All Rooms. 
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Locate and select the desired room click on the Rooms button. The room is displayed in the text box. Click OK. 
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To view room availability click on [image: image215.png]Scheduling
“Assistant



. From this view the room and people schedules can be checked. Room and attendees can be added by clicking on Add Rooms or Attendees button.   
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To set the schedule review view click on the Options button and select the options wanted. 
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Dates and times can be changed using the drop down lists. 
[image: image218.png]Al s

‘Add Rooms. End time: Mon 12/3/2007 ¥ | |7:30 AM -]




Outlook 2007 also offers alternative options for when people and rooms are available. 
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Click on the appointment button on the tool bar. 
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Verify that the Subject line is filled and the date and times are correct. Use the text box to add detailed information about the meeting. 
[image: image221.png][[Fo.. ) [Davidson-wwhitehead, Jud; (OCIO) Lincon 501

subject [Test

Send

Location:[[0GI0 lincen 301 8idg Room 4€

Start time: [ Mon 12/3/2007 V| [630am V| Oa
End time: | Mon 12/3/2007 | [730am v





Click on the Insert Tab to attach a document, attached item, business care or signature to the meeting notice. 
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Click the Send [image: image223.png]


 button. 

Add Color to Calendar

To add color to calendar entries click on Edit then Categorize. Click on the desired color category.
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Use the text box to rename it and click yes.
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How to use color categorization

After entering the meeting or appointment information click on Categories in the options area of the menu bar. Click on the color (category) the entry best fits. Once the entry is saved and or sent it shows up on calendar shaded in the selected color. The entry will be displayed on the printed document in a shaded area in this color when the color print option is selected. 
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Create a Task
Access the Task feature by clicking on “Task” in the menu side bar. 
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Click on “New” in the menu bar along the top of the screen. 
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In the subject line enter the name of the task or project. Use the down arrows for the start and end dates. Click the down arrow for Status, select from the options available by clicking on it.
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Set the priority for the task by clicking on the down arrow, select from the options available. 
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Use the up and down arrows to set the % complete, select from the options available. 
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To set up the task reminder click on the Reminder check box. Use the calendar and time drop down boxes to set the date and the time. 
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In the text portion of the screen enter the information for the task. 
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Once the task creation is complete click on “Save & Close”.
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Assign a Task
If all or part of a task is to be done by someone else Outlook can be used to assign the task. Once the task is created click on the “Assign Task” button. 
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Click on “To” to use the Outlook directory feature to select the assignee, you can also direct entry the email address in the To box. In the text section, enter the instructions and other supporting information.  Outlook gives you the option to keep a copy of the task on your list, simply click on the check box. If a completion notification is wanted click on the status report check box.  Click on the “Send” button to send the task to the assignee. 
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Update a Task

Locate the task on your list. Double click on it to open.
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Items that can be changed are the due date, status, priority, and % complete. Additional text can be entered to explain the changes. 
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Click on the “Send Status Report” button to send a status report to others. 
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Address the report and click the “Send” button. 
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Close a Task

Locate the task on your list. Double click on it to open. 
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Click on the “Mark Complete” button. The task is completed and the view is closed. 
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Another option is to click on task in list to select and click on the Mark Complete icon in the tool bar along the top of the screen. 
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Delete a Task
Locate the task on your list. Double click on it to open. 
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Click on the “Delete” button.
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Prompt asks if you really want to do this, click “Yes” to delete. 
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The task is deleted and the view is closed. 

Another option is to click on task in list to select and click on “delete icon in the tool bar along the top of the screen. 
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